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If You Have Problems

If You Have Problems

Please visit our service and support page at https://www.gamry.com/support-2/. This page contains information
on installation, software updates, and training. It also contains links to the latest available documentation. If you
are unable to locate the information you need from our website, you can contact us via e-mail using the link
provided on our website. Alternatively, you can contact us one of the following ways:

Internet https://www.gamry.com/support-2/
Telephone (215) 682-9330 9:00 AM—5:00 PM US Eastern Standard Time
(877) 367-4267 Toll-free US & Canada Only

Please have your instrument model and serial numbers available, as well as any applicable software and
firmware revisions.

If you have problems in installation or use of a system containing Echem Analyst 2 software, please try to call
from a phone next to your computer, where you can type and read the screen while talking to us.

We will be happy to provide a reasonable level of free support for registered users of the Echem Analyst 2
software. Reasonable support includes telephone assistance covering the normal installation, use, and simple
customization of a computerized system containing Echem Analyst 2 software connected to a Windows®-
compatible computer.

A service contract that extends the software update period is available at an additional charge. Software
updates do not include software enhancements offered to our customers at additional cost.

Enhancements to the Echem Analyst 2 software that require significant engineering time on our part can be
performed on a contract basis. Contact us with your requirements.

Copyrights

Echem Analyst 2™ Software Operator’s Guide copyright © 2008—2023 Gamry Instruments, Inc., all rights
reserved.

Gamry Framework copyright © 1989—2023 Gamry Instruments, Inc., all rights reserved.
Framework™ and Gamry™ are trademarks of Gamry Instruments, Inc.
Windows® is a registered trademark of Microsoft Corporation.

No part of this document may be copied or reproduced in any form without the prior written consent of
Gamry Instruments, Inc.

License Agreement

Gamry Instruments, Inc. grants you, the Purchaser, a non-exclusive license to use the software programs
included in this package, including updates which may later be provided by Gamry Instruments at additional
cost. This license is subject to the terms and restrictions set forth in this Agreement.

License

The software programs and the Operator’s Guide are protected by both United States copyright law and
international treaty provisions. Accordingly, these software programs remain the property of Gamry
Instruments, Inc. as its sole property, subject to the rights granted to you in this License Agreement.



Disclaimers

You may:

e Make archival copies of the software programs for backup purposes only. All backup copies must
include the Gamry Instruments, Inc. copyright notice.

e Transfer the programs and Gamry potentiostat from computer to computer within your facility.

e  Operate the data-acquisition (Framework™) and data-analysis portion (Echem Analyst 2™) of the
programs on an unlimited number of computers within your facility.

e Transfer the programs, with a copy of this license, to another party, provided the other party agrees to
accept the terms and conditions of this Agreement. If you transfer the programs, you must at the same
time transfer all copies of the programs to the same party or destroy any copies not transferred. If you
transfer possession of any copy of the software programs, in whole or in part, to another party, your
license is automatically terminated.

You may not:
e Sublicense, rent or lease the software programs.
e Use this program with a potentiostat not specifically authorized by Gamry Instruments, Inc.
e Modify the program and/or potentiostats to defeat the authorization code security scheme.
e Reverse engineer, decompile, or disassemble any program module or programmable logic device.

e Copy, use, modify, or transfer the software programs or Operator’s Manuals or any copy, in whole or
in part, except as expressly provided in this Agreement.

Term

This license is effective until terminated. You may terminate it by destroying or returning the programs and
Operator’s Manuals and any copies thereof. This license will terminate if you fail to comply with any term or
condition of this Agreement.

Governing Law

This License Agreement shall be governed by the laws of the Commonwealth of Pennsylvania. If any provision
of this License Agreement is found void, invalid, or unenforceable, it will not affect the other terms and
conditions of this Agreement, which remain valid and enforceable.

Third-Party / Use Sublicenses

Gamry software may incorporate Third-Party or Use Sublicenses (such as Qt or other math-related Python
software). In this case, the terms and conditions of their License Agreements (available during Setup) will apply.

Disclaimers

Gamry Instruments, Inc. cannot guarantee that the Echem Analyst 2 software will work with all computer
systems, operating systems, and third-party software applications, hardware, or software.

The information in this guide has been carefully checked and is believed to be accurate as of the time of
release. However, Gamry Instruments, Inc. assumes no responsibility for errors that might appear.

No part of this document may be copied or reproduced in any form without the prior written consent of
Gamry Instruments, Inc.

Windows®, Excel®, and PowerPoint® are registered trademarks of Microsoft Corporation. Origin® is a registered
trademark of OriginLab Corporation. DigiSim® is a registered trademark of Bioanalytical Systems, Inc.
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Introduction to this Guide

Chapter 1: Introduction to this Guide

The Echem Analyst 2™ software is Gamry Instruments’ dedicated data-analysis program, the companion to
Gamry Instruments’ data-acquisition program called Framework™. Data files generated by experiments in
Framework software then can be analyzed in the Echem Analyst 2. The Echem Analyst 2 is a single program
that runs data-analysis for all types of experiments, such as those used in DC Corrosion, EIS, and Physical
Electro-chemistry.

The Echem Analyst 2 is designed with the specific functions to make data analysis as straightforward as possible.
This manual explains the most common analysis routines. The tools discussed here in the examples are
common to many data files created by other experiments. This document is a guide and is not intended to
have the same scope as the on-line help or a complete operating manual. In order to create a concise
document, we assume you have a working knowledge of Windows®-based applications. We ignore details
about common functions, such as opening, saving, and closing files, so as not to obscure the goal of this guide.






General Information and Overview — Installation

Chapter 2: General Information and Overview

Installation

Echem Analyst 2 installs separately from other Gamry software. If the Echem Analyst 2 is not installed yet, you
can find it on our website at www.gamry.com if you already own one of our instruments.

You may install copies of the Echem Analyst 2 on multiple computers. Often users prefer the convenience of
performing data-analysis at an office workstation, rather than the laboratory setting.

File Formats

Gamry data files acquired using Framework software have the extension * . DTA. All * . DTA files are ASCII text,
and therefore you can open them directly into various programs, such as Excel® or Origin®. When * . DTA
files are opened in Echem Analyst 2, then saved, their extension becomes * . gp£. All *.gp£f (Gamry Project
File) files include information on curve-fits and graphing options, thus * . gp£ files are only viewable in Echem
Analyst 2.

Do not delete your * . DTA files! They are the raw data and may need to be re-loaded for
certain analyses, such as area normalization.

V

( GET
Gamry’s previous data analysis version, the Echem Analyst, used a different file format which
saved their data as * . GData (Gamry Data) files. These files can’t be opened anymore in the newest
Echem Analyst 2 version and require the older Echem Analyst version. Please contact your local Gamry
representative or Gamry support for more information or directly visit our website at www.gamry.com.

Depending on the region where you live in, the number format may differ to the standard Gamry file format.
Hence, we suggest checking the Windows® Region Settings of your computer and enable Unicode UTF-8
support.

"\

< =3 v~ 1 & > ControlPanel > Clockand Region

Control Panel Hi .
ontrol Fanel ome Date and Time

System and Security Set the time and date | Change the time zone | Add clocks for different time zones

Network and Internet Ai Region

Hardware and Sound Change date, time, or number formats

Programs

User Accounts ] Region Settings e

Appearance and
Personalization Select which language (system locale) to use when displaying text in

programs that do not support Unicode. This setting affects all user
accounts on the computer.

Clock and Region

Ease of Access
Current system locale:

Dutch (Netherlands) ~

\» Beta: Use Unicode UTF-8 for worldwide language support




General Information and Overview — Open a Gamry Data File

2 gﬁ
{3{’(,@ |

For best international character display support, use Unicode UTF-8 settings in Windows.

Open a Gamry Data File
There are several different methods to open data files in the Echem Analyst 2:
1. Launch the Echem Analyst 2 icon on your desktop. -/:’-—-f'\h
Then use the File > Open function. Ll =
2. Use the link on your desktop to open the My Gamry Data folder. F_-:)

Double-click on the data file. You may have to instruct your computer to associate the * . DTA
extension with the Echem Analyst 2 program.

3. There are two quick ways to open a recent Gamry Data File:

a. Arecently generated file can be opened using the hotlink in the Analysis menu in the Gamry
Framework. The last eight generated data files are listed there for quick access. The Echem
Analyst 2 automatically launches and opens your selected data file.

b. A recently opened file in the Echem Analyst 2 is shown at the bottom of the File menu. This is
similar to how other Windows®-based programs display links to Most Recently Used
documents.

By default, files acquired in the Framework are saved into the My Gamry Data folder. A shortcut for My
Gamry Data is installed on the Windows® desktop. You can change this default under Tools > Options,
which opens the Gamry Analysis Framework Options window. Choose the General tab and change the Path
for each type of data file as desired.

s‘DB,{'

el
(0@(3[7.
Do not change the directory for any Analysis Script Files! These are the Python programs that
do the actual analysis.

The data set appears in the main window. The menu items, tabs, and toolbar are adjusted for the particular
type of data set you chose. In the example below, a Potentiostatic EIS data set is shown:

10




General Information and Overview — Working with Plots in the Echem Analyst 2

£) Echem Analyst 2 [Sample Potentiostatic EIS.DTA] - o X
file Help Tools Impedance Common Tools

p=B

Potentiostatic EIS

10.00 kohm - £10.00°
...................................... £ 0.000°
.....
......... teeseccesssssssssannna,, E-10.00°
.
.
- -
. E-20.00°
A ! )
£ x ) g
=1.000 kohm - . E-3000°R
k| . o
g )
N
E-40.00°
.
. o
& F-50.00
.
.
.
M R R R F R R
E-60.00°
100.00 ohm - ! ! ! ! ! ! ! ! 70000
10.00 mHz 100.00 mHz 1.000 Hz 10.00 Hz 100.00 Hz 1.000 kHz 10.00 kHz 100.00 kHz 1.000 MHz 10.00 MHz
Freq (Hz)

Note the tab-based display. The Experimental Setup tab displays all the information from the parameters used
to run the experiment, such as voltage, time, etc. The Experimental Notes tab stores any notes written into the
setup screen in Framework. The Open Circuit Voltage tab shows the voltage measured during the initial delay
of the experiment. The Hardware Settings tab records in-formation on the filters, ranges, gains. Additional
information on date of last calibration, software version, etc. is also stored here

Working with Plots in the Echem Analyst 2

Menu

The Echem Analyst 2 displays at the top line the menu bar. Three functions are universal which are File, Help,
and Tools.

e File

o Open, overlay files, save, print, and exit
e Help

o Includes the user manual and software information
e Tools

o Tools to customize software scripts
o Options to customize the graph interface
o Perform EIS Batch Fit on your data

The other commands in the menu depend on the data file and the experiment type. The raw data file
(*.DTA) includes a line that indicates the type of experiment used to generate the file in Echem Analyst 2.

The first command is named after the experiment type and includes experiment-specific commands. The
second is called Common Tools and includes various functions to format the graph, see Chapter 3:Common
Tools.

(~~) Echem Analyst 2 [Sample Potentiostatic EIS.DTA]

File Help Tools Impedance Common Tools

v-EB_UW

Bode Nyquist Experimental Setup Experimental Notes Open Circuit Voltage Hardware Settings




General Information and Overview — Working with Plots in the Echem Analyst 2

Menu toolbar
The most common file commands are separately listed in the Menu toolbar below the menu bar.

(#2) Echem Analyst 2 [Sample Potentiostatic EIS.DTA]

File Help Tools Impedance Common Tools

22 =S ©

Bode Nyquist Experimental Setup Experimental Notes Open Circuit Voltage Hardware Settings

v, <2 0 @ | [
A @ s

| A Q ¥ X

The following chart lists all commands on the Menu toolbar.

Table 2-1
Menu toolbar functions

Button Name Function
t’; Open File Open a * .DTA or *.gpf data file.
= Open Overlay Open a * . DTA file of the same experiment type to overlay with the

current data.

E Save Save data file as Gamry Project File (*.gpf)
Print Print the plot.
@ Exit Close the Echem Analyst 2.
Graph toolbar

The Echem Analyst 2 boasts a number of graphical tools to help you get the most information out of your data.
After you open a data set, these tools appear in the toolbar immediately above the plot.

(-7) Echem Analyst 2 [Sample Potentiostatic EIS.DTA]

File Help Tools Impedance Common Tools
P = @

Bode Nyquist Experimental Setup Experimental Notes Open Circuit Voltage Hardware Settings

=) :::_::‘ I A \'d b oo

The Graph toolbar includes general functions for replotting, graph formatting, and data handling. The following
chart lists all commands on the Graph toolbar.

12



General Information and Overview — Working with Plots in the Echem Analyst 2

Table 2-2
Graph toolbar functions

Button Name Function
Copy to clipboard Copy the selection to the Windows® clipboard. Paste the file directly in
- Microsoft programs for reports or presentations.
e Select X Region Select a desired region of the plot across the x-axis.
i Select Y Region Select a desired region of the plot across the y-axis.
) Select Portion of Curve Left-click on the active trace using the mouse to select a section of the
- using the Mouse curve.
Draw Freehand Line Draw a line on the plot.
36 Enable/Disable Points  Enable or disable points settings.
u\ Shgw/Hide Disabled Show or hide data points not being used in the plot.
Points
“ f Pan Let’s you see different areas of a zoomed view.
L Zoom Zoom in on a selected region.
Auto-Scale Automatically adjust x-axis and y-axis range to display the full curve.
Vertical Grid Toggle between showing and hiding vertical grid lines on the plot.
Horizontal Grid Toggle between showing and hiding horizontal grid lines on the plot.
. Properties... Open the GamryChart Properties window, so that you can adjust
effects, colors, markers, lines, etc.
Print Chart Print the plot.

13




General Information and Overview — Changing the Axes on a Plot using the Curve Selector

Changing the Axes on a Plot using the Curve Selector

To choose a different variable plotted on an axis, use the Curve Selector button as follows. The example
shown below is a Differential Pulse Voltammetry plot:

1. With the plot open and displayed on the screen, click the Curve Selector button on the right side.

) Echem Analyst 2 [Sample Differential Pulse Voltammetry.DTA]
File Help Tools Differential Pulse Voltammetry Common Tools

v=BoN

vvvvvvvvvv
1 I Q P QR =+ § > CLRVE (Sampe Differental Puise e
Vit

Diff Pulse CURVE (Sample Differential Pulse Vol

-100.0 nA 4

-200.0 nA

-300.0 nA

1dif (A)
=

<<%
aF

&
H
—
23232
o
g

~400.0nA i
|del' Idif lIrey

%
oz
330

-500.0 nA -

~600.0 nA -

T T T T T T ]

~750.00 mV ~700.00 mV -650.00 mV -600.00 mV. -550.00 mV. -500.00 mV -450.00 mV -400.00 mV
fwd

The Curve Selector area appears on the right side of the window.
2. Choose which trace is active by clicking the drop-down menu in the Active Trace area.

The Active Trace is the data series on which the analysis will be performed. Use this if multiple files or
cycles are displayed on the graph.

3. Choose which trace is visible on the plot by activating the checkbox next to the desired trace(s) in the
Visible Traces area.

Visible Traces also contains any data fits that are performed.

4. Choose which variable is plotted on the x-axis by highlighting the variable in the X-Axis column.

5. Choose which variable is plotted on the y-axis by highlighting the variable in the Y-Axis column.
6. Choose which variable is plotted on the second y-axis by highlighting the variable in the Y2-Axis
column.
&
&“Do.{'

ol
If there is a data column graphed on the Y2-Axis, those data appear in a different color and a
different scale.
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General Information and Overview — Selecting Portions of a Curve for Analysis

Selecting Portions of a Curve for Analysis

For certain types of analysis, you must select a region of the curve, for example, within the Peak Find function
in Cyclic Voltammetry or Tafel Fit function in Potentiodynamic.

e Left-click the mouse on the Select Portion of Curve using the Mouse button in the Graph Toolbar.

e

e Use the left mouse-button to select each endpoint of the curve. Each endpoint is marked with a blue
cross. The selected portion of the curve is shown as a thick blue line. In the figure below, the color of
the data was changed to red for contrast to the selected region.

Cyclic Voltammetry

20.0 pA

10.0 pA-|

0.0A

Im (A)

-10.0 pA

-20.0 pA

-30.0 uA -t . . .
100.00 mv 200.00 mV 300.00 mv 400.00 mV
Vf (V vs. Ref.)

T 1
500.00 mV 600.00 mV

e Another click on the Select Portion of Curve using the Mouse button clears the selected region and
readies the graph for a different region to be selected.

Enable/Disable Points of a Curve

In some cases, measurement data can contain data points that are clear outliers caused by noise or other
sources or some points are not useful for fitting data. In such cases, points can be disabled and back again

enabled.
Disable Data Points
1. In the Graph Toolbar, click the Enable/Disable Points button. gg

2. The Disable/Enable Points settings window appears.

() Disable/Enable Points Settings ? *
Mode Select By
(®) Disable (@) Point
() Enable () series
Cancel

15



General Information and Overview — Enable/Disable Points of a Curve

3. Select the Disable mode.
If you want to disable only single points, select Point on the right side.

For disabling a range of data points, select Series on the right side.

4.  Within the data plot, select the points you want to disable. All marked points are highlighted by a

blue %.

Cyclic Voltammetry

20,0 pA

10.0 p | s

0.0A

Im (A)

-10.0 pA

/

-20.0 pA |

-30.0 uA

T T T T T
100.00 mv 200.00 MV 300.00 MV 400.00 MV 500.00 mv
Vf (V vs. Ref.)

5. Confirm or discard your selection by either right click your mouse

Dizable Points
Discard Selection

or click the Enable/Disable Points button in the Graph Toolbar.

' Disable/Enable Points

Exiting Disable/Enable Points Tool.
Save Changes?

16
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General Information and Overview — Enable/Disable Points of a Curve

6. The data curve is shown without the disabled data points.

Cyclic Voltammetry
20,0 pA

10.0 pA s

0.0A

Im (A)

-10.0 A |

20,0 pa |

S T T T T 1
100.00 mv 200.00 my 300.00 mv 400.00 my. 500.00 MV 600.00 My

Vf (V vs. Ref.)

7. If you want to see all the disabled points in your data curve, click the Show/Hide Disabled Points
button in the Graph Toolbar. f‘\

All disabled points are highlighted with a red %.

Cyclic Voltammetry

20,0 pA
10.0 p | s

0.0A

Im (A)

-10.0 pA

-20.0 pA |

2l T T T T 1
100.00 mv 200.00 MV 300.00 MV 400.00 MV 500.00 mv 60000 V.
Vf (V vs. Ref.)

Enable Data Points
1. In the Graph Toolbar, click the Enable/Disable Points button. gg

2. The Disable/Enable Points settings window appears.



General Information and Overview — Enable/Disable Points of a Curve

() Disable/Enable Points Settings ? x
Mode Select By
() Disable () Paint
(® Enable ®) Series
Cancel

3. Select the Enable mode.
If you want to enable only single points, select Point on the right side.
For enabling a range of data points, select Series on the right side.
4. The data plot shows all disabled points highlighted by a blue %.
Select the data points you want to enable again. The selected points are highlighted by a green X.

Cyclic Voltammetry

20.0 pA

10.0 pA -

0.0

Im (A)

-10.0 pA |

-20.0 pA

-30.0 uA

7 T 7 7 J

100.00 mV 200.00 mV 300,00 mv 400.00 mV 500.00 mv 600.00 mV
Vf (V vs. Ref.)

5. Confirm or discard your selection by either right click your mouse

Enable Points

Dizcard Selection

or click the Enable/Disable Points button in the Graph Toolbar.

(=) Disable/Enable Points

Exiting Disable/Enable Points Tool,
Save Changes?

Dhiscard

6. The data curve is shown with all the enabled points again and without the remaining disabled data
points.

18



General Information and Overview — Cut and Paste Images and Data

Cyclic Voltammetry
20.0 pA

10.0 pA - F.

Im (A)

-10.0 pA

-20.0 pA |

-30.0uA - : : -
100.00 mv 200.00 mv 300.00 mv 400.00 mv
Vf (V vs. Ref.)

T 1
500.00 MY 600.00 mv

7. If you want to see all the disabled points in your data curve, click the Show/Hide Disabled Points
button in the Graph Toolbar. ﬂ\

All disabled points are highlighted with a red %.

Cut and Paste Images and Data

Many users want to present, publish, or otherwise share their data and charts from the Echem Analyst 2. The
Copy to clipboard button allows to copy data as an Image or as Text (data only) to the clipboard for further
processing.

As an Image
1. In the Graph Toolbar, click the Copy to clipboard button.

(#7) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]

File Help Tools Cyclic Voltammetry Common Tools

v-B.@

Chart Experimental Setup Experimental Notes Electrode Settings Hardware Settings

w  —

v, = )
\‘\ v \

Q

W | % do
As an Image {

As Text (data only)
-

2. In the drop-down menu select As an Image.

3. Animage of the graph enters the clipboard. You can paste this file into a presentation program such as
Word® or PowerPoint®.

This is a quick and easy way to import a picture of the graph for a presentation or report
As Text
1. In the Graph Toolbar, click the Copy to clipboard button.

2. In the drop-down menu select As Text .

3. The Gamry Data File is copied in ASCII format to the clipboard.

19



General Information and Overview — Plotting Conventions

Because Gamry Data Files are ASCII text, they can be opened easily in other graphing programs, such
as Excel® or OriginLab®. Right-click on the DTA file, select Open With..., and select your desired
program. These programs, however, do not contain fitting routines specific to the analysis of
electrochemical data. This As Text feature lets you fit the data in Echem Analyst 2 and then copy and
paste the data and fit into another graphing program.

This is a quick and easy way to import both the data and the fit into another graphing program.

{

o
( If you are using the As Text feature, be sure to note the currently graphed parameters. The
coordinates of the currently displayed graph are copied and can be pasted to other graphing programs.

s‘_pi,l'f l

Plotting Conventions

By right-clicking the mouse on a non-zero value on an axis, you can choose to show that particular axis in Log
Scale (logarithmic) or linear scale (when Log Scale is inactive).

Edit Title...
Change Title Font...
Change Title Color.
Change Axis Label Font.
Edit X Axis...

T Make Axis Scaler
1.000 pA 10.00 pp———— 100.00 pA

Im (A)

You can also use the Transform Axes selection (if available) under the Common Tools menu.

<) Echem Analyst 2 [Sample Potentiodynamic (Dummy Cell).DTA]
File Help Tools Potentiodynamic Common Tools
V ~ E @ Add E Constant t
Add | Constant
Chart Experimental Setup Experimenta Post-Run iR Correction ware Settings EL
Linear Fit

o2 A | Smooth Data
Q] Py

Transform Axes

{

e The Transform Axes window appears.
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General Information and Overview — Cetting Online Help and Version Number

[&7] Transform Axes ? x

Volta
s
@) vs. Eref () vs. Eoc

X-Axis
Style

) Linear @ Log
[] reversed

Y-Axis
Style

@ Linear O Log
[] Reversed

Y2-Axis
Style

@ Linear O Log
[] reversed

You can also reverse the direction of the numbers when Reversed is active.

&
*TDO'M l
(Og(,af .
Default plotting of graphs is auto-scale. Therefore, note the y-axis’ scale when a plot first

appears. If bad data points obscure your data because of auto-scaling, you can choose to disable and hide
those offending points.

Getting Online Help and Version Number

In the main menu, choose Help.

~7) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]
File  Help Tools Cyclic Voltammetry Common Tools

el

User Manual

About Echem Analyst 2

¢ C(lick User Manual to open the Echem Analyst 2 operator’s guide and obtain information about
various commands and functions of the Echem Analyst 2.

e Click About Echem Analyst 2 to view the software version number.
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Common Tools — Accessing Common Tools

Chapter 3: Common Tools

While each type of experimental data has its own method and parameters, there are certain commands that
are common to many analyses. This section shows you these Common Tools.

Accessing Common Tools

1.

Open a dataset.
In the menu, the function Common Tools appears.
Choose Common Tools.

A drop-down menu appears.

Echem Analyst 2 [Sample Chronoamperometry.DTA]

File Help Tools Chronoamperometry Common Tools

V E @ Add E Constant

Add | Constant
Chart Second Chart Experimental Setup Post-Run iR Correction s Hardware
Linear Fit ‘
| & ) Smooth Data

» Bl X oo NN g | @

Select the desired command.

In this example, Chronoamperometry’s Common Tools includes five commands: Add E Constant,
Add I Constant, Post-Run iR Correction, Linear Fit, and Smooth Data.

Note that Linear Fit is inactive. This command requires at first to select a portion of the curve to be
active.

s’bvo,('

ol
L

{0

The list of Common Tools functions varies depending upon the type of experiment.
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Common Tools — Accessing Common Tools

Table 3-1

List of Common Tools functions

Command Type of experiment Result
Add E Cyclic Voltammetry, DC Voltammetry, Adds a constant potential to all
Constant Differential Pulse Voltammetry, Galvanic voltages in the plot. Used to easily
Corrosion, Normal Pulse Voltammetry, Pitting convert between different Reference
Scan, Polarization Resistance, Potentiodynamic Electrode’s scales.
Scan, Square-Wave Voltammetry
Add | Chronoamperometry, Chronopotentiometry, Adds a constant value to all currents in
Constant Cyclic Voltammetry, Galvanic Corrosion, Pitting  the plot.
Scan, Polarization Resistance, Potentiodynamic
Scan
C from CPE, Potentiostatic EIS, AC Voltammetry, Mott- Calculates capacitance from
omega(max) Schottky previously fit CPE values and data
from the Nyquist plot.
C from CPE, Potentiostatic EIS, AC Voltammetry, Mott- Calculates capacitance from
R(parallel) Schottky previously fit CPE and fit R data.
Linear Fit Chronoamperometry, Potentiostatic EIS, AC When a region of the plot is selected,
Voltammetry, Chronocoulometry, fit the datatoy = mx + b.
Chronopotentiometry, Cyclic Voltammetry, DC
Voltammetry, Differential Pulse Voltammetry,
EMF Trend, Galvanic Corrosion, Mott-Schottky,
Normal Pulse Voltammetry, Polarization
Resistance, Potentiodynamic Scan, Square-Wave
Voltammetry
Post-Run iR Cyclic Voltammetry, Polarization Resistance, Corrects a previously run scan for
Correction Potentiodynamic Scan voltage-drop caused by iR.

Smooth Data

Transform
Axes

Chronoamperometry, Chronopotentiometry,
Cyclic Voltammetry, DC Voltammetry,
Differential Pulse Voltammetry, EMF Trend,
Galvanic Corrosion, Normal Pulse Voltammetry,
Pitting Scan, Polarization Resistance,
Potentiodynamic Scan, Square-Wave
Voltammetry

Galvanic Corrosion, Pitting Scan, Polarization
Resistance, Potentiodynamic Scan

Smooth data. Useful for locating peaks
in regions of high data-density.

Changes x- and y-axes from linear to
logarithmic, etc.
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Experiment Tabs — Chart
Chapter 4: Experiment Tabs

When analyzing an experiment in the Echem Analyst 2 by opening a * . DTA file, the experiment window
opens, displaying a default data curve. The experiment window is divided into various sub-tabs, each displaying
various information about the measurement data, experimental setup, hardware settings, and additional notes.

The various Experiment Tabs are discussed using a Cyclic Voltammetry experiment data file.

Chart

By default, graph is displayed in the Echem Analyst 2 when opening a * . DTA file. The plotted curve depends
hereby on the experiment and is displayed within the first tab.

Depending on the experiment, more than one chart can be listed under the Experiment Tabs. In this example,
only one chart tab is displayed.

+7) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]
File Help Tools Cyclic Voltammetry Common Tools

—F-2-0

Chart Experimental Setup Experimental Notes Electrode Settings Hardware Settings

20.0 pA j

Data points, axis format, and graph layout can be formatted using the toolbar functions and
experiment-dependent menu functions.

Experimental Setup

The Experimental Setup tab shows the experiment parameters set in Gamry Framework™ software.

<) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]

File Help Tools Cyclic Voltammetry Common Tools

g-BD_@
m Experimental Setup Experimental Notes Electrode Settings Hardware Settings

Data File ' Sample Cydic Voltammetry - Ferricyanide.DTA

Initial E (V) 0.6 s. Eref s. Eoc Scan Limit 1 (V) 0.1 s. Eref s. Eoc
Scan Limit 2 (V) 0.6 s. Eref s. Eoc Final E (V) 0.6 s. Eref s. Eoc

Test Identifier

Time

Scan Rate (mV/s)
Step Size (mV)
Electrode Area (cm”2) 0.0707

Equil. Time (s)

Max Current (mA)

Conditioning Off 15.0  Time(s) 0.0 E(V)

Init. Delay Off 30.0 Time(s) 0.0 Stab.(mV/s)

Cydes (#)
IRComp None

Open Circuit (V)
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Experiment Tabs — Experimental Notes

This example has many of the same parameters as other experiments. It shows:

Parameter Information

The potentials defining the waveform, and whether measured vs.
a reference electrode (Eref) or the open circuit potential (Eoc).

Initial E, Scan Limit 1,
Scan Limit 2, Final E

Test Identifier Adds a constant value to all currents in the plot.

Time Time the experiment was started.

Scan Rate How fast (in mV/s) the scan was taken.

Step Size The interval between potentials.

Electrode Area The size of the electrode.

Equil. Time How much time was spent letting the electronics settle before the

scan was started.

I/E Range Mode

Max Current

Conditioning

Init. Delay
Cycles
IR Comp

Open Circuit

Sampling Mode

Automatically adjusted or fixed I/E (Current) Range mode.

The current value that sets the I/E Range in Fixed Mode and
determines the range in which to start in Auto Mode.

Whether off or on, for how long, and under what potential. This
Potential is vs. Reference.

Whether off or on. This is when the Eoc is measured.
Number of how many voltammetry cycles were run.
If IR Compensation was used and the mode.

The value of the open-circuit voltage (Corrosion Potential). It is
the value of the last point in the Initial Delay.

Data-acquisition mode (for Reference family Potentiostats).

Experimental Notes

Any notes entered in the Framework™ software are automatically displayed in the Experimental Notes tab.
You may enter any additional comments about the experiment in the Notes... field.

(¢7) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]

File Help Tools Cyclic Voltammetry Common Tools

Chart Experimental Setup Experimental Notes Electrode Settings Hardware Settings

Data File 'Sample Cydlic Voltammetry - Ferricyanide.DTA

Notes... | pt electrode
1M NacCl 10 ml
+200 ul 0. 1M FeCN6 [ 2mM Fe(CN)6 ]
+200 ul 0.5M H2S04 [ 10 mM H2504]
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Experiment Tabs — Electrode Settings
This is a version of a modern laboratory notebook. Enter as many details about your experiment as you can.
Information here can help you avoid having long strings of descriptive file names.
Electrode Settings

The Electrode Settings tab documents any specific settings and information about the electrode used in the
experiment, e.g., Electrode Type. The Electrode Settings tab is not available for all experiments.

() Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]

File Help Tools Cyclic Voltammetry Common Tools
g = 310
Chart Experimental Setup Experimental Notes Electrode Settings Hardware Settings

Data File |Sample Cydlic Voltammetry - Ferricyanide.DTA

Electrode Type Solid

Used for Stripping off

Hardware Settings

The Hardware Settings tab documents the hardware settings that were used when the experiment was run,
e.g., everything from the offsets, filters, and gains to the last time the potentiostat was calibrated.

(#2) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]

File Help Tools Cyclic Voltammetry Common Tools

v-Bo@

Chart Experimental Setup Experimental Notes Electrode Settings Hardware Settings

Data File |Sample Cydic Voltammetry - Ferricyanide.DTA

Potentiostat PC4300 Pstat Model PC4/300

Control Mode Potentiostat Current Convention Cathodic

Control Amp Speed Slow 1/E Stability Medium

1/E AutoRange off 1/ERange 300 pA

Ich Auto Range off Vch Auto Range Off

Ich Range 3v Vch Range 3v

Ich Filter SHz Vch Filter 1kHz

Ich Offset Enable off Vch Offset Enable Off

Ich Offset (V) 0.0 VehOffset (V) 0.0
Positive Feedback IR Comp off Positive Feedback Resistance (ohm) 0.0
1/E Range Lower Limit 3nA Ach Range 3V

The Hardware Settings displayed in this example are listed in the table below. A detailed explanation of these
parameters is beyond the scope of this guide.
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Experiment Tabs — Hardware Settings

Parameter

Information

Potentiostat

Control Mode

Control Amp Speed

I/E AutoRange

Ich AutoRange

Ich Range

Ich Filter

Ich Offset Enable

Ich Offset

Positive Feedback IR Comp

I/E Range Lower Limit

Ach Select

DC Calibration Date
Framework Version
Pstat Model
Current Convention
I/E Stability

I/E Range

Vch AutoRange
Vch Range

Vch Filter

Vch Offset Enable

Vch Offset

Positive Feedback Resistance

Ach Range

Cable ID

AC Calibration Date

Instrument Version

Shows the potentiostat’s label.

How the experiment was controlled.

Shows the speed of the control amplifier.

Shows if the I/E AutoRange function was enabled.
Shows if the Ich AutoRange function was enabled.
Shows the Ich range (gain). 3 volts = X1 Gain.
Shows the Ich cut-off filter frequency.

Shows if Ich Offset was enabled.

Shows the Ich offset voltage.

Shows if the IR positive feedback was enabled.

Shows the lowest available I/E Range available to use in this
experiment.

Shows the input connector for Ach.

Shows the date of last DC calibration

Shows the Framework Version when experiment was performed.
Gives the model number of the potentiostat.

Shows which currents are positive.

Shows the I/E stability speed.

Shows the I/E (or current) range used.

Shows if Vch autoranging is enabled.

Shows the maximum value for Vch.

Shows the Vch cut-off filter frequency.

Shows if Vch Offset was enabled.

Shows the Ich offset voltage.

Shows the positive feedback resistance applied to the system.
Shows the voltage range of the auxiliary channel.

Gives the type of cable connected to the system (for Reference
family potentiostats only).

Shows the date of last AC calibration.

Shows the Firmware Version of a Reference family potentiostat.
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Experiment Tabs — Open Circuit Voltage

Open Circuit Voltage

The Open Circuit Voltage tab is active if the experiment includes an open circuit potential measurement
before the actual experiment. It is required for any experiment that uses potential reference versus Eoc.

20.00 pV

0.000V—

-20.00 pV -

-40.00 pv -

Vf (V vs. Ref.)

60.00 pV -+

80.00 v

100.00 !

-120.00

-140.00 !

v

V-

Open Circuit Voltage

V-
0.000s

20005 40005 6.000s 80005 10.00s
T(s)

s’bi,{'f

(()QGET

Because default plotting of graphs is auto-scale, please note the y-axis’ scale when the Open

Circuit Voltage first appears.
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Analysis of Cyclic Voltammetry Data — Cyclic Voltammetry Special Tools

Chapter 5: Analysis of Cyclic Voltammetry Data

The figure below shows the cyclic voltammogram of a sample cyclic voltammetry file that installs in \My
Gamry Data\ when Gamry Instruments’ Framework software is installed.

Figure 5-1
Cyclic Voltammogram of Ferricyanide in an aqueous NaCl solution on a Pt working electrode
() Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA] - o X
File Help Tools Cyclic Voltammetry Common Tools
P-B-@
1 Q % XKo@ s
Cyclic Voltammetry
20.0 pA
10.0 pA
0.0A-
g
£
-10.0 pA -
-20.0 pA
-30.0 UA - - - - T 3
100.00 mv 200.00 mV 300.00 mV 400.00 mV 500.00 mV/ 600.00 mV/

Vf (V vs. Ref.)

Cyclic Voltammetry Special Tools
This menu analyzes the cyclic voltammetry data.
1. In the main menu, choose Cyclic Voltammetry. A drop-down menu appears.

(¢2) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]

File Help Tools @ Cyclic Voltammetry _Common Tools

ﬁ = E Min/Max

Integrate
Chart i 2 -
. == Region Baselines

Clear Regions

» =00 Normalize by Scan Rate
Normalize by Square Root of the Scan Rate

20.0 pA - Peak Find =
Clear Peaks
Automatic Baseline
Peak Baselines
Clear Lines

Delta Ep

10.0 pA - 2
Subtract Background From File

Export to DigiElch

Cyclic Voltammetry Options

2. Choose the desired tool.
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Analysis of Cyclic Voltammetry Data — Integrating the Voltammogram

Tool

Function

Notes

Min/Max

Quick Integrate

Integrate

Region Baselines

Normalize by Scan
Rate

Normalize by Square
Root of the Scan Rate

Peak Find

Clear Peaks
Automatic Baseline
Peak Baselines

Clear Lines

Delta Ep

Subtract Background
from File

Export to DigiElch

Options

Finds the minimum and maximum currents and
voltages within the dataset. Results appear in a
window below the plot.

Integrates to find the total charge. Results appear
in a window below the plot.

Integrates over a specified portion of the plot to
find the total charge.

Defines a line as the baseline for a specified
region.

Normalizes the dataset based on the scan rate.

Normalizes the dataset based on the square-root
of the scan rate.

Finds peaks within a specified region of the
dataset.

Clears all peaks found within the dataset.
Finds the baseline automatically.
Defines a line as a baseline for a specified peak.

Clears all lines from the dataset.

Finds the potential difference between two
peaks.

Subtracts a background amount from the
dataset.

Exports the file to a DigiElch-compatible format.

Changes units and grids for plotting the data.

For multi-cycle CV
experiments.

Portion of the curve must
be selected.

Region must be selected.

Portion of the curve must
be selected.

Peaks must be identified.
Peaks must be identified.
Peaks must be identified.

Lines must be associated
with graph.

Peaks must be identified

Integrating the Voltammogram

All integration methods integrate current versus time to get the total charge. There are two different ways to
integrate under a curve with Echem Analyst 2.

Integrate

Integrate requires you first to select a portion of the curve. See how to select a portion of the curve in the
“Selecting Portions of a Curve for Analysis paragraph in Chapter 2. After an integration is performed, you can
change the baseline from the default O A to another line, either a line that you draw, or an Automatic

Baseline.

1. Open the data file.

2. Select the Draw Freehand Line button.
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Analysis of Cyclic Voltammetry Data — Integrating the Voltammogram

(#) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]
File Help Tools

g=B.W

Cyclic Voltammetry Common Tools

Chart Experimental Setup Experimental Notes Electrode Settings Hardware Settings
2 IR ¥ — B e | e .
| HE QY % RO R 4

’ Draw Freehand Line

Left-click and hold on the graph to place an anchor point. Holding down the mouse button, extend
the line with the mouse. Move or extend the line as you wish.

Click next to the line to accept. After you accept the line, it turns from blue to a black solid line. The
line is added to the Visible Traces window on the right side where the line can be edited or deleted.

@ Echem Analyst 2 [Sample Cyclic Voltarmmetry

ide.DTA]

Filc Holp Tools Cyclic Voltammetry Comme

v-B-@

Owt | Sosmrsite  Eocwelills | Sercetive | HiweSsig  Insosti

AT

(CRVEL Geroe Gz akammet -Farcs

HIE QY R A+ QAR |mle] 5
et
Cyclic Voltammetry \ [ CURVEY (Sample Cyclic Votammetry
20.0 pA L2 Line? (slope=6068 WA, intercept=

100 pA

00A
<
< >
E
- s P T
None
-10.0 vA 3
w
in
¥
o
A
iERanae
Geer
Crarac
200 pA
30.0uA-

100.00 mv.

20000 mv.

wm'o mv
VF (V vs. Ref.)

400.00 m.

500.00 mV 600.00 mv

Select the portion of the curve to integrate. This function is described in detail earlier.

Select Integrate from the Cyclic Voltammetry menu.

@ Echem Analyst 2 [Somple Cyelic Voltamme
File Help Tools | Cyclic Voltammetry | C:

V=B

Min/Max

Peak fina
Clear Pealcs

Automatic Bascline

Prak Baselines

Clear Lines

Detta Ep

Subtract Background From File
Export to DigiElch

100pA

Cyclic Voltammetry Options

Im (A)

“10.0 pA

200 A

300uA-

te.DTA)

e gt

Cyclic Voltammetry

acta s
AL Gerpe Gy Vtmmnet Forcke.
Ve Tces
[ CURVE! (sample Cycic Vortammetyy
[Z Line1 (slope=6068 A, intercept=

100.00 mv.

30000 my
Vf (V vs. Ref.)

200.00mv.

40000 m.

50000 my 600.00 mv.
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Analysis of Cyclic Voltammetry Data — Integrating the Voltammogram

This integrates the selected section between the curve and the zero line and display the calculated
charge of the area.

To change the baseline to the desired user-drawn line, select Region Baselines from the Cyclic
Voltammetry menu.

(#) Echem Analyst 2 [Sample Cyclic Voltammetry - Ferricyanide.DTA]
File Help Tools Cyclic Voltammetry Common Tools
ﬁ = Min/Max
Integrate

Region Baselines
Clear Regions

Chart Experiment:

Normalize by Scan Rate
Normalize by Square Root of the Scan Rate

20.0 pA - Peak Find -
Clear Peaks
Automatic Baseline
Peak Baselines
Clear Lines
Delta Ep

10.0 pA -
. Subtract Background From File

Export to DigiElch

Cyclic Voltammetry Options

The Region Baseline Settings window appears.

Select the desired baseline from the available lines. You may draw multiple lines from which to
choose.

The integrated region moves from the default 0 A baseline to the user-drawn line.

(CREL Gerpe e Vabammet -Faroee.

Nene = s -
Line? (s0pe-6.068 AN, ml.-u-.,y..ms.m,n,...m! L Cyclic Voltammetry ‘E:j:::;»sm“:f‘::“:z

Im (A)
:
S‘?g ;

-10.0 pA

o=

o

200 uA - ! ! |
100.00 mv 200.00 mv 300,00 mv 400.00 mV. 500.00 mV. 600.00 mv
Vf (V vs. Ref.)
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Modeling Polarization Resistance Data — Polarization Resistance Special Tools

Chapter 6: Modeling Polarization Resistance Data

Polarization Resistance Special Tools
This menu analyzes the polarization resistance data.

1. In the main menu, choose Polarization Resistance.

+7) Echem Analyst 2 [Sample Polarization Resistance.DTA]

File walarization Resistance  Common Tools
l‘/ - E Min/Max

Polarization Resistance

It Sxoemen Polarization Resistance Options == Hordweore Setings
s | - do K | @ ¢
A drop-down menu appears.
2. Choose the desired tool:
Tool Function
Min/Max Finds the minimum and maximum currents and

voltages within the dataset. Results appear in a
window below the plot.

Polarization Resistance ~ Within a selected portion of the curve, finds the

polarization resistance.

Polarization Resistance  Changes units and grids for plotting the data.
Options

Finding the Polarization Resistance
Method 1: Manual Entry of the Tafel Constants

Finding the Polarization Resistance requires you first to select a portion of the curve. See how to select a
portion of the curve in the “Selecting Portions of a Curve for Analysis” paragraph in Chapter 2.
1. In the main menu, choose Polarization Resistance.

A drop-down menu appears.

+7) Echem Analyst 2 [Sample Polarization Resistance.DTA]

File Help Tools Polarization Resistance Common Tools

V) ~ E Min/Max
Polarization Resistance
Chart M e Hardware Settings

Polarization Resistance Options

V) ‘ VI V) o

go A | ‘" 4

» | — -’

2. Choose Polarization Resistance.

The Polarization Resistance window opens.
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Modeling Polarization Resistance Data — Finding the Polarization Resistance

(&7 Polarizat.. 7 X

Seed Values

Beta A |0,12000 %
Beta C |0,12000 =

Close Calculate

3. In the Seed Values area, enter anodic (Beta A) and cathodic (Beta C) Tafel constants.
4. Click the Calculate button.

5. The calculated Corrosion Rate appears in a window below the plot.
Method 2: Automatic Selection of Voltage Region

The Echem Analyst 2 offers another way to automatically select the voltage region over which this analysis is
done.

1. In the Polarization Resistance menu, choose Polarization Resistance Options.

(7 Echem Analyst 2 [Sample Polarization Resistance.DTA]
File Help Tools Polarization Resistance Common Tools
V/ = E Min/Max
Polarization Resistance

Chart Experiment: S = . e Hardware Settings
Polarization Resistance Options 2

The Polarization Resistance Options window opens.

[87 Polarization Resistance Options ? X

Units for Time

Seconds bt Name :' Factor 1.00000 :

D Use for Open Circuit Data

Units For Voltage Data Grid
O L D Display grid for each data table
© vs, Eref
SetRegion
Units for Current
© Automatic
() Current Density /
Ecorr (mV) +/-
@ Current O e
Alternative 1V
© Voltage on Y Axis Save As Defaults

Voltage on X Axis
O g Apply Close

2. Select the Automatic radio button, specify the region around Ecorr to use, and click the Save as
Defaults button. You are prompted directly for Tafel constants when a polarization resistance file is
opened.

This is how Gamry Instruments’ RpEc Trend experiments calculate the corrosion rate.
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Modeling Potentiodynamic (Tafel) Data — Tafel Fit

Chapter 7: Modeling Potentiodynamic (Tafel) Data

A Tafel experiment is also a very popular electrochemical corrosion technique. The following analysis is
performed on the sample Potentiodynamic data file.

Tafel Fit

1. Select the region over which to perform the Tafel fit. This region must encompass the Ecorr (open-
circuit potential).

2. Select Tafel Fit from the Potentiodynamic menu:

Potentiodynamic Scan

_/

Im (A)

2000 34

3. A Tafel Fit window appears where you may input seed values optionally for the fit.

-~

(87 Tafel Fit X

Use Seed Values
-

Iterations: 150

Seed Vallues

Icorr: |0.000001

Ecorr:  |-3.2788E-05

Bets A: [0.12

BetaC: [0.12

Weighting

@ Log O Linear O Average

The better the information we provide the fitting routine, the more likely it will be able to generate an
acceptable fit.

If you have reasonable starting parameters for the fit, input them in the Seed Values area, and check
the Use Seed Values checkbox. If you do not have any confidence at all in your range of parameters,
do not check the Use Seed Values checkbox.

We recommend using the seed values supplied by the Echem Analyst 2.
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Modeling Potentiodynamic (Tafel) Data — E Log | Fit

4. Click the Calculate button.

5. When you click the Calculate button, the changes can be subtle. The following events occur:
e The parameters in the Tafel Fit window become the fit parameters.
e Afitline is displayed on the graph.
e Anew Tafel tab is created (to the right of the Hardware Settings tab) that holds the
information about the fit.

/ %) Echem Analyst 2 [Sample Potentiodynamic (Dummy Cell)

file Help Tools Potentiodynamic Common Tools
p-B-@
i =)

Chart  Experimental Setup  Experimental Notes  Open Circui

Potentiodynamic Scan

o Parameter Value
1 Beta A 6.166 V/Decade
3 e 2 BetaC 6.106 V/Decade
§ _— . e i e 3 lcorr 41740 pA
4 Ecorr 52.57 WV

o = 5 Corrosion Rate 190.70 mpy

6 ChiSquared  0.1274

7 Data File Sample Potentiodynamic (Dummy Cell).DTA

pro pET [ T T Tt 2 Fit Status

E Log I Fit

The E Log I fit is a useful fit if you want to fit the data one branch (anodic or cathodic) at a time. This can be
important if one branch doesn’t show linear behavior, but the other does.

The fit is called E Log I because of the semi-logarithmic nature of a Tafel plot. The x-axis is the logarithm of
current, while the y-axis is potential on a linear scale.

Method

1. Select a portion of the curve.
Here you need only the linear section of one of the branches. This selection does not include Ecorr,

i.e., Eoc (open-circuit potential).

2. Select E Log I Fit from the Potentiodynamic menu.

Potentiodynamic Scan

Vf (V vs. Ref.)
i
I
It

Im (A)

3. Inthe E Log I Fit window, enter an approximate value for Ecorr.



Modeling Potentiodynamic (Tafel) Data — E Log | Fit

4. Click the Calculate button.

[E7 E Log...

?

>

Ecorr |-9,28802¢-06

| Volts

-
Calculate

A single branch of the Tafel data is fit. The fit is shown on the graph, and the results of the fit are

contained in a new E Log I tab.

VF (v v Ref.

)

() Echem Analyst 2 [Sample Potentiodynamic (Dummy Cell).DTA
Eile Help Tools

Potentiodynamic
p-B =W

Chart Experimental Setup

Common Tools

Experimental Notes Open Circui

Parameter Value

614.20 mV/Decade

2 Ecorr

-9.288 v
3 Icorr 30.08 pA

4 Corrosion Rate 13.74 mpy

5 Data File Sample Potentiodynamic (Dummy Cell).DTA

You can run a Polarization Resistance fit on these Potentiodynamic data if the axes of current are changed to
the linear scale. Generally, we suggest running a separate experiment on a new sample of the same material
because of the more polarizing, more destructive nature of the Potentiodynamic experiment.
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Modeling EIS Data — Bode and Nyquist Plot View
Chapter 8: Modeling EIS Data

The data-analysis features shown here are common to many of the AC-based techniques. By far the most
popular type of AC experiment is Potentiostatic EIS.

Bode and Nyquist Plot View

Click the Bode tab or the Nyquist tab of the plot you prefer to work with. All fits are displayed on both the
Bode and Nyquist plots. Because they are different representations of the same data, the fit results are identical.

Figure 8-1

Bode plot
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Modeling EIS Data — EIS Special Tools

EIS Special Tools

EIS data-analysis uses an equivalent-circuit approach. This menu creates and runs fits for EIS data. Commands
in this menu allow you to build an equivalent-circuit model in the Model Editor, then fit that model to your
data. This menu also lets you run advanced procedures, such as Subtract Impedance, and run Kramers-
Kronig transforms.

1.
2.

In the main menu, choose Impedance.

A drop-down menu appears.

~) Echem Analyst 2 [Sample Potentiostatic EIS.DTA]
File Help ylmpedance Common Tools

V = E] Model Editor
Fit A Model (Levenberg-Marquardt Method)
Bode Nyquist Fit a Model (Simplex Method)
Subtract Impedance...
Kramers-Kronig
Distribution of Relaxation Times
Min/Max

Clear All Fits

Impedance Options
ar

To create or edit an equivalent circuit, choose Model Editor.
The Impedance Model Editor window appears. See the next page for how to use it.
Choose your fitting method.

To fit the data using the Levenberg-Marquardt method, choose Fit A Model (Levenberg-Marquardt
Method).

e The Select Model File window opens.
e Choose the appropriate model file and click the OK button.
To fit the data using the Simplex method, choose Fit A Model (Simplex Method).

e Simplex method weighs the user’s seed values less. We recommend using the Simplex
method.

To subtract an impedance from the data, choose Subtract Impedance....
The Impedance Subtraction window appears.

Choose your parameters:

Method Function

Element Choose a circuit element from the drop-down
menu.

Model Browse for a previously defined model.

Spectrum Browse for a data-set.

Click the Close button.
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Modeling EIS Data — The Model Editor

9. To use the Kramers-Kronig method, choose Kramers-Kronig. Kramers-Kronig is a model-
independent transform that checks the EIS data for consistency.

The Kramers-Kronig window appears.
10. To clear all fits from the plot, choose Clear All Fits.

11. To change time or impedance units, choose Options. This option lets you normalize the data and fits
to the normalized area.

The Model Editor

The Impedance Model Editor allows you to create an equivalent circuit. You can select between a variety of
circuit elements to build your own model or open a pre-built model.

7 Madel Editor

File hem Help
Bl XG L[k

Companents

ket N e s

Resistor Capaditor

o BwA
(S — > -
oz f

s’pvﬁ.l'f l
fORGEr S

There are several pre-loaded models. Often users find it convenient to start with one of these
models and edit it as needed.
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Modeling EIS Data — The Model Editor

Figure 8-3
Circuit Elements
Symbol Element Comments
. : Resistor Abbreviated as R.
(R Z=R
! : Capacitor Abbreviated as C.
—— 7 = —ilaC
| : Inductor Abbreviated as L.
_*-\_Qﬁxf Z=iol
. . Constant Phase Models an inhomogeneous property of the system, or a property
& Element with a distribution of values. Often abbreviated as CPE.
Connection Node Add a connection to the model.
u
. : Gerischer Element Models a reaction in the surrounding solution that happened
—G— already; also used for modeling a porous electrode. Often
abbreviated as G.
. : Infinite Warburg Models a linear diffusion to an infinite planar electrode. Often
—W— abbreviated as W.
| . Bounded Warburg Models diffusion within a thin layer of electrolyte, such as
WA electrolyte trapped between a flat electrode and a glass
microscope slide. Often abbreviated as T.
| - Porous Bounded Models diffusion through a thin layer of electrolyte, such as
WS Warburg electrolyte trapped between an electrode and a permeable
membrane covering it. Often abbreviated as O.
— Bisquert Open (BTO) Transmission line with Z; = o boundary condition. Only pore
“Gpen (B70)" reactions are considered; base electrode is insulating.
— Bisquert Short (BTS) Transmission line with Z; = 0 boundary condition. Only pore
"Shert (BT5)" reactions are considered; electrode is non-insulating.
— Unified (UTL) Transmission line with a variety of free parameters.
"(um)

Building an Equivalent Circuit

1. Adding an element:
Left-click on an element symbol.

Left-click on the open area to place the element.

2. Connecting elements:

Click on the Add Connector Line symbol in the toolbar.
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Modeling EIS Data — The Model Editor

(57 Model Editor

File Item Help

SPPE %0 £ Fabs
Campenents [ Add Connector Line |

e Left-click one end of the wire and drag the end to the element.
The element’s border turns blue when the wire’s end reaches the element.

e Add a Connection Node if additional connections are required.

&
s’bo.{'f l
Be sure to connect the circuit to the reference-electrode symbol ®€- and the working-

-

electrode symbol *.E..

Here is an example of a simple equivalent circuit (a Randles model) constructed in the Impedance Model
Editor:

7 Model Editor - /P mdi = o X

File Iltem Help
Bl 0 £~ [k N\

Components

>

Inductor ConstPhasetle —>'l—|_| -9
¥ we
=G BweH Ru Rp
Gerischer BoundWar
=W Wi I
ct

Infinteviar  PorousBoundiar

e =
oo Sy
810 o1
united

o 1 &

un ConnectionNode

<

Badkgrounds < 5

3. Deleting an element:
e Right-click on the element.
The Delete command appears. Press Delete.

e Left-click on the Delete symbol in the toolbar.

[E7] Model Editor

File ltem Help

P -
ECJVE@ x@ ‘v Q'\mo%v
Components Delete i

Left-click on any element to be deleted.

4. Relabeling and fixing parameters for an element:
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Modeling EIS Data — The Model Editor

The Set Item Parameter tool lets you rename the element, specify its parameters, and set a Lower and
Upper Limit for its value. Renaming the element helps you distinguish between elements of the same
type during fitting. Giving the program limits on the parameters may help the mathematical algorithm.
For example, we know values are generally positive, so a Lower Limit = O is reasonable to set. There
are two way to set element parameters:

Left-click on an element.

Left-click on the Set ltem Parameter symbol in the toolbar.

[E7 Model Editor

File ltem Help /
a7 =
P Bl O £~k N

Components

The Set Parameter window appears.
Right-click on the name of the element (in this example a resistor).
The Set Item Parameter command appears. Press Set ltem Parameter.

The Set Parameter window appears:

| Set Parameters ? X

Parameter Name: ‘R solution v

——
Initial Value: M ohm

Lower Limit Test

Enable o | ohm
Upper Limit Test
[] Enable o | ohm

Enter a new Parameter Name.
Enter an Initial Value, i.e., the first trial value for fitting.

In the Lower Limit Test and Upper Limit Test fields, enter lower and upper limits, and check
the Enable checkbox, as desired.

Click the OK button.

The Set Parameter window closes and the element is set to these parameters.

Compiling the Equivalent Circuit

When the equivalent circuit is complete, the circuit can be compiled before use to check for connectivity of
the wires. Compiling is only used to check connections

1. Click File > Compile in the Model Editor menu.
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Modeling EIS Data — The Model Editor

[E7] Model Editor
File | tem Help
New Ctrl+N
Open Ctrl+0
Open Recent L4
Save Ctrl+5
Save As Ctrl+A
\ Compile Cirl+C
Exit Ctrl+X

The software compiles the equivalent circuit.

If there is a problem, such as a missing connection, an error message appears, and a red box outlines
the problem element.

Click the OK button to continue.
Inspect the schematic and make necessary corrections.

If the equivalent circuit compiles properly, a message appears to confirm the successful compiling
process.

7] GamryEchemAnalyst X

The model compiled successfully

Click the OK button to continue.

Save the equivalent circuit with an * . md1 extension by clicking the Save Model File button in the
toolbar.

[E7] Model Editor

File Item HeIpA/
A

BBl i £k o>
Components ‘

The File Save As window appears.
The default folder for saving model equivalent circuits is the Models folder.
Name and save the file here or choose a different folder.

The File Save As window closes.
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Modeling EIS Data — Fitting the Data to the Equivalent-Circuit Model

Fitting the Data to the Equivalent-Circuit Model
1. With the data open and plotted, click Impedance, and choose Fit A Model (Simplex Method).

<) Echem Analyst 2 [Sample Potentiostatic EIS.DTA]

File Help Tools Impedance Common Tools

V = E‘] Model Editor

Fit A Model (Levenberg-Marquardt Method)
Bode Nyquist Fit a Model (Simplex Method)
/ Subtract Impedance...
A s Kramers-Kronig

T Distribution of Relaxation Times
Min/Max

Clear All Fits

Impedance Options

£l

The Select Model File window appears.
2. Choose the desired model.

The default folder for models is the Models folder. This Models folder is by default in the
C:\ProgramData\Gamry Instruments\Echem Analyst 2\models directory.

Click the Open button.

3. The Select Model File window closes and the Impedance Fit by the Simplex Method window
appears.

[E7 Impedance Fit by the Simplex Method ? b

AutoFit Calculate Preview Close

Model Parameters

Reset to Default Values

Rp |1000.0000 ohms [] Lock <Rp
Ru |50.0000 ohms [] Lock <Ru
Cf |1.0000e-05 F [lock < Cf

Advanced ¥

4. Click the AutoFit button or set parameters.

Enter estimates for all the circuit elements in the Model Parameters area. Fix particular elements by
enabling their Lock checkboxes.

e In this example, we try 50 Q for Ru, 1000 Q for Rp, and 10 uF for Cf and leave all of them
free (unlocked).

5. If you don’t use the AutoFit button, click the Calculate button to start the fit.

The software attempts to fit the model to the data. When finished, the fitted parameters appear next to
each circuit element.

The model in this example gives following fit parameters:
° Rp =3 kQ
e Ru=199.7 Q (solution resistance)

e (Cf=980nF
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Modeling EIS Data — Fitting the Data to the Equivalent-Circuit Model

[E7 Impedance Fit by the Simplex Method 7 »

AutoFit Calculate Preview Close

Model Parameters

Reset to Default Values

Rp 30004256 ohms [] Lock <Rp
Ru |199.6600 ohms [] Lock <Ru
Cf |9.8015e-07 F [lock < Cf

Advanced ¥

&
‘;_DO"‘T

(o«(ﬂ!

model.

If your fit fails, try different starting Model Parameters, or even a different equivalent-circuit

Like other Echem Analyst 2 fits, the fit also appears superimposed upon the data and a new tab is created that
contains those results.

&) Echem Analyst 2 [Sample Potentiostatic EIS.DTA] - o X
File Help Tools Impedance Common Tools
wode st Ranotes
- v oo {‘\ = Ay L4
Potentiostatic EIS
10.00 kohm 10.00 ©
......... e R e £0.000 ©
S -
Yo, "
. «
.
R i e o [ -10.00 ©
e Y o
.
. e A
R ¥
- \
. B2 °
\ p, 20.00
z . LN
3 \ \ ¢ £
1,000 kohm - LU £-3000° R
\ " ~
3 . 3
£ . \ z
N R
\ .
b \ F-40.00 °
w4
. \
\
L] \ F-50.00 °
- \.\
\ E
™ - e R S
o F-60.00 ©
100.00 ohm - : . . . . . . . \£-70.00
10.00 mHz 100.00 mHz 1.000 Hz 10.00 Hz 100.00 Hz 1.000 kHz 10.00 kHz 100.00 kHz 1.000 MHz 10.00 MHz
Freq (Hz)

If you try another fit using the same model, it will display a second fit and add a counter to the fit's name. If
you fit to another model, the fit results of both models will be displayed.

This new tab shows the residual errors and goodness of fit, along with the various plotting tools. Residuals are a
point-by-point Goodness of Fit, which quantifies how closely the data match the fit. A smaller number
indicates a better fit.
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(2) Echem Analyst 2 [Sample Potentiostatic EIS.DTA]

- o
file Help Tools Impedance Common Tools
P
= = /
wode st RANDLES
Farametey Valtey || eEror: (|Units RANDLES Fractional Residual Errors
1 Rp 30004256 13.0287 ohms 0.004  0.006
2 Ru 1996600 08957 ohms
3 cf 9.8015e-07 7.5387e-09 F
4 Goodness of Fit 53716-06 0.002
5 Status Message: Success L 0.004
& Sample Potentiostatic EIS.DTA 1 /\M
/\‘/\/\ PSS
v Y v
= -0.002
5 ]
i \
N \
) I
® -0.002 \ I\
3 | I
= / \ |
freq  ResidualZreal ResidualZimag 2 / \ |
/ \
q |
1 10001e+06 -64011e-03  -69197e-04 © /" ‘w\ | Fo
|
.05 - . g / \ |
2 79439405 -19436e-03  32341e-03 o | \ |
3 63098e+05 -83174e-04  5.5560e-03 \ i /
4 501236405 71161e04  58237e-03 1 N /
5 39811e+05 -79182e-04  5.2628e-03 W A --0.002
-0.006 B
6 3.1627e+05 -8.2711e-04 4.3080e-03
7 251200405 2004204  37264e-03 ]
8 19955405 -15658e-04  32091e-03
9 15842e+05 -69317e04  22368e-03 -0.008 u T T T T T T 7--0.004
0.0 0.1 1 10 0 1,000 10,000 100,000 1e+06 1e+07
10 12595¢+05 -1.1449¢-03  1.7897e-03 Freq (Hz)
11 999780000 -69575e-04  27877e-03 e v O B R I 2

The blue data (Zreal) correspond to the y1-axis (on the left); the green data (Zimag) correspond to the y2-axis

(on the right).
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Headings in Data-File Columns

Appendix A: Headings in Data-File Columns

DC Data Files

Abbreviation  Meaning

Pt Point number

T Time

Vm, Vf Measured voltage

Im Measured current

Vu Uncompensated voltage

Sig Signal from the signal generator

Ach Aucxiliary channel

IE Range I/E (Current Measurement) range on which measurement was made
Over Any overloads. Numeric record of different overload types
0 No overloads

EIS Data Files

Abbreviation  Meaning

Freq Frequency

Zreal, Zimag,  Calculated values of impedance
Zmod, Zphz

Idc, Vdc DC component of current and voltage

Yreal, Yimag ~ Admittance (calculated from Z)
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Current Conventions According to FrameworkTM and Echem Analyst 2

Appendix B: Current Conventions According to Framework™ and
Echem Analyst 2

The current convention in the Framework software for all experimental packages is that an anodic/oxidation
current is positive.

To change the current convention (whether anodic/oxidation currents or cathodic/reduction currents are
positive), in the menu Tools > Options > Units tab, specify the current you want represented as positive. The
current convention can be changed by editing the experimental script (contact Gamry Instruments or your
Gamry Instruments representative if you need to do this). Regardless of the current convention used in the
Framework, it can be changed in the Echem Analyst 2 to the one you desire (see below for exceptions).

s‘DB,('

ol
The current convention affects all experiments run under the Physical Electrochemistry and
Pulse Voltammetry heading. No other data files are affected.

To change the current convention in the Echem Analyst 2, in the menu Tools > Options > Units tab specify
the current you want represented as positive

To change the current convention in other experimental packages (DC Corrosion, EIS, etc.) please contact
Gamry Instruments or your Gamry Instruments representative.
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Appendix C: Index Control Mode, 28
Conventions, 20, 28, 53

Copy to clipboard, 13, 19

* .DTA, 9, 10, 11, 25 Copy to Clipboard, 19
* GData, 9 Corrosion Rate, 36
*.gpf, 9 Current Convention, 28
*.mdl, 47 Curve Selector, 14

Cut, 19

Cycles, 26

AC Calibration Date, 28 Cyclic Voltammetry, 15, 31, 33, 34

Ach, 51

Ach Range, 28

Ach Select, 28 data fit, 14

Active Trace, 14 DC Calibration Date, 28
Add Connector Line, 44 Delete, 45

Add E Constant, 23, 24 Delta Ep, 32

Add I Constant, 23, 24 DigiElch, 32

Analysis menu, 10 Draw Freehand Line, 13, 32
As an Image, 19

As Text, 19, 20 E Log | Fit, 38

ASCII/.9, 19 E Log I Fit window, 38
AutoFit, 48 E Log I tab, 39
Automat.m, 36 ' Ecorr, 38

Automatic Baseline, 32 EIS, 41, 42

Auto-Scale, 13 Electrode Area, 26

Electrode Settings tab, 27

Beta A, 36 element, 44, 46

Beta C, 36 Enable checkbox, 46

Bisquert Open (BTO), 44 Enable/Disable Points, 13, 15, 17
Bisquert Short (BTS), 44 Equil. Time, 26

Bode plot, 41 equivalent circuit, 44, 46, 47
Bode tab, 41 Excel®, 9

Bounded Warburg, 44 Experiment Tabs, 25

experiment window, 25
Experimental Notes, 11, 26
Experimental Setup, 11, 25
Export to DigiElch, 32

C from CPE, omega(max), 24
C from CPE, R(parallel), 24

Cable 1D, 28

Calculate, 38, 39, 48

Calculate button, 36 File, 11, 46

calibration, 28 File menu, 10

Capacitor, 44 File Save As window, 47

Changing the Axes, 14 Final E, 26

Chart, 25 Firmware Version, 28

Clear All Fits, 43 fit, 14

Clear Lines, 32 Fit A Model (Levenberg-Marquardt Method), 42
Clear Peaks, 32 Fit A Model (Simplex Method), 42, 48
Common Tools, 11, 20, 23, 24 Framework Version, 28

Compile, 46 Framework™ software, 7, 25, 26, 53
computer, 3, 4 Freq, 51

Conditioning, 26
Connection Node, 44, 45

GamryChart Properties, 13
Constant Phase Element, 44

General, 10

contract engineering, 3 General Toolbar, 15,17, 19
Control Amp Speed, 28
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Gerischer Element, 44
Goodness of Fit, 49
Graph toolbar, 12, 13

Hardware Settings, 11, 27
Hardware Settings tab, 38
Help, 11, 21

Horizontal Grid, 13

I/E AutoRange, 28

I/E Range, 28

I/E Range Lower Limit, 28
I/E Range Mode, 26

I/E Stability, 28

Ich AutoRange, 28

Ich Filter, 28

Ich Offset, 28

Ich Offset Enable, 28

Ich Range, 28
Idc, 51

IE Range, 51
Im, 51

Impedance, 42

Impedance Fit by the Simplex Method window,
48

Impedance Model Editor, 43, 45

Impedance Model Editor window, 42

Impedance Subtraction window, 42

Inductor, 44

Infinite Warburg, 44

Init. Delay, 26

Initial E, 26

Initial Value, 46

Installation, 9

Instrument Version, 28

Integrate, 32, 33

IR Comp, 26

Kramers-Kronig method, 43
Kramers-Kronig transforms, 42
Kramers-Kronig window, 43

Levenberg-Marquardt method, 42
Linear Fit, 23, 24

Lock checkbox, 48

Log Scale, 20

Lower Limit, 46

Lower Limit Test, 46

Max Current, 26
menu bar, 11, 12
Menu toolbar, 12

Index
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Min/Max, 32, 35

Model Editor, 42

Model Parameters area, 48
Models folder, 47

My Gamry Data folder, 10

Normalize by Scan Rate, 32

Normalize by Square Root of the Scan Rate, 32
Notes..., 26

Nyquist plot, 41

Nyquist tab, 41

Open Circuit, 26

Open Circuit Voltage, 11, 29
Open function, 10

Open With..., 20

Options, 10, 32, 35, 43, 53
Origin®, 9

Over, 51

overload, 51

Pan view, 13

Parameter Name, 46

Paste, 19

Path, 10

Peak Baselines, 32

Peak Find, 15, 32

plots, 11

Polarization Resistance, 35, 36, 39
Polarization Resistance Options, 35, 36
Polarization Resistance Options window, 36
Polarization Resistance window, 35
Porous Bounded Warburg, 44
Positive Feedback IR Comp, 28
Positive Feedback Resistance, 28
Post-Run iR Correction, 23, 24
Potentiodynamic, 37, 38, 39
Potentiostat, 28

Potentiostatic EIS, 41

Print Chart, 13

Properties..., 13

Pstat Model, 28

Pt, 51

Quick Integrate, 32

Randles model, 45

Region Baseline Settings window, 34
Region Baselines, 32, 34

Resistor, 44

Reversed, 21



Sampling Mode, 26

Save as Defaults, 36

Save Model File, 47

Scan Limit 1, 26

Scan Limit 2, 26

Scan Rate, 26

Seed Values area, 36, 37

Select Model File window, 42, 48
Select Portion of Curve, 15, 32, 35
Select Portion of Curve using the Mouse, 13
Select X Region, 13

Select Y Region, 13

Selecting Portion of Curve, 15
Selection Toolbar, 15

service contract, 3

Set Item Parameter, 46

Set Parameter window, 46
Show/Hide Disables Points, 13, 17, 19
Sig, 51

Simplex method, 42

Smooth Data, 23, 24

Step Size, 26

Subtract Background from File, 32
Subtract Impedance, 42

Subtract Impedance..., 42
support, 3, 53

T, 51

Tafel Constants, 35, 36
Tafel Fit, 15, 37

Tafel Fit window, 37, 38
Tafel tab, 38

telephone assistance, 3
Test Identifier, 26

Time, 26, 51

toolbar, 25

Tools, 11, 53
Transform Axes, 20, 24
Transform Axes window, 20

Unified (UTL), 44

Units, 53

Upper Limit, 46

Upper Limit Test, 46

Use Seed Values checkbox, 37
User Manual, 21

Vch AutoRange, 28
Vch Filter, 28

Vch Offset, 28

Vch Offset Enable, 28

Index
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Vch Range, 28

Vdc, 51

Vertical Grid, 13

Vf, 51

Visible Traces, 14

Visible Traces window, 33
Vm, 51

Vu, 51

website, 9
Windows, 3

X-Axis column, 14

Y2-Axis column, 14
Y-Axis column, 14
Yimag, 51

Yreal, 51

Zimag, 50, 51
Zmod, 51
Zoom, 13
Zphz, 51
Zreal, 50, 51



